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Congratulations! You have purchased the finest quality importable images
available anywhere. All were designed and illustrated by professional artists
working in a variety of artistic media, including oil paints, pen and ink, water
color, acrylic and more. Originally collected at the specific request of profession-
al designers, graphic artists and advertising executives, these timeless images are
now available to you, royalty-free, to use in all your creative projects.

As you browse through the 100 timeless illustrations provided on this disc, you
may recognize some striking images you’ve seen on best-selling greeting cards,
calendars, posters and publications. It’s no coincidence. Wood River Gallery’s
long list of prestigious clients includes Hallmark Cards, Gibson Greetings,
Landmark Calendars, Portal Publications and Walden Books. 

Making your own picture perfect creations is easy. 

Now you can add these classic Pictures NOW!™ illustrations to your fax cover
page, create your own four-color letterhead, add graphics to your favorite cal-
endar program, design your own personalized greeting cards, make attention-
getting posters, name tags, banners, newsletters, calendars, brochures and much
more. All you need is one Pictures NOW! disc (or several), your PC or Macintosh,
an application that can import pictures, and a printer. 

Just follow the simple instructions on the next few pages to browse through the
images on your Pictures NOW! disc, using the Kudo® image browser included on
the disc. Select the pictures you like, and import them into your favorite applica-
tion. Once placed in your document the way you like it, just print as you would
normally. 

All pictures are available in two formats (PICT and TIFF) for easy inclusion with
many of the applications you use now. Both file types are stored in the folder
named CONTENT. Windows™ users will find TIFF files. Macintosh® users will find
both PICT and TIFF files. PICT files are inside the folder with the full subject name, 
e.g. Animals. TIFF files are inside the folder with the abbreviated subject name,
e.g. ANIMLS.

MAKE ALL YOUR CREATIONS PICTURE PERFECT!
From Wood River Gallery

TM



INSTRUCTIONS FOR WINDOWS USERS
Start Up. 

1. Insert the CD-ROM disc into your ROM drive (using a disc caddy if
appropriate).

2. Select RUN from the File Menu.
3. Type the following into the Command Line:  “d:winstall” if “d” is the

designation of your CD-ROM drive.  Type “e:winstall” if “e” is the
designation of your CD-ROM drive.  Kudo will install itself on your
hard disk, usually c drive.

4. Restart your computer when prompted to do so.

As part of the installation process, Kudo creates a new group and an icon which
will start Kudo and allow you to view the different pictures from your CD ROM as
“thumbnails” (small versions) of the actual picture.

Browsing with Kudo.

To search Pictures NOW! for the images you want to use, double-click the
Pictures NOW! icon. You will see a catalog window with thumbnail images on
your monitor.

Use the three “View” buttons at the top left of the catalog window to select the
view you prefer.

Small Gallery View, the left-hand view button, shows many images at once at 1/4
their normal size, but with no file details. Click the “Info” button at the top of
the screen for more information on any selected thumbnail.

The Gallery View, the center view button, uses a grid-style layout showing several
thumbnails and their file type. Click the “Info” button for more information.

List View, the right-hand view button, uses a vertical layout with fewer thumb-
nails in the window, but offers more information about each file.

You can scroll through the images grouped by subject on the disc, or search for
specific images.

To find groups or sets of images by type or subject, use the “Find” button, top
left of the catalog window. Select “Keywords” from the first pull-down menu in
the Find dialog box. Type the subject or word you wish to search for in the right-



hand text field, then click “Find.” The thumbnail images containing your keyword
will appear in the window. If no matches are found, try another keyword.

You may also sort images using the other search options offered in the pull-down
menus. A printed Picture Index is included in each package to make your image
selection easier.

To preview any image click once on its thumbnail, then choose “Preview” from the
Image pull-down menu. Kudo will find the actual image and display it in a full-sized
window. Check the “Better Colors” box to view a more detailed image on 256
color monitors. Click the “Close Window” box in the upper left corner of the win-
dow to exit the preview utility.

Importing Pictures NOW!™ images into your favorite programs.

The following procedure will work with most Windows applications which are
OLE 2.0 compliant. If the import procedures described here do not work with
your application, skip ahead for application-specific instructions. 

1. Start Kudo by double-clicking the appropriate icon in the Kudo
Image Catalog group.

2. Choose the thumbnail that you wish to copy into another
application.

3. From the Kudo Image Catalog pull-down menus, select “Edit.”
4. Select “Copy Thumbnail.”
5. Start or select the application you wish to copy the picture into,

and position the insertion point at the place you wish to have
the picture appear.

6. Select “Edit.” Select “Paste.” A full-size copy of the picture will
appear in the desired location.

Windows Applications - Specific Import Procedures.
If the application you are using is not listed here, check the index of your appli-
cation documentation for “importing” and/or “pictures” and follow the instruc-
tions in the manual provided with the software .

Calendar Creator Plus™-Softkey International, Inc.®

To include a picture in your calendar use Power Album:
Select “Picture,” then select “Add to Album.”



Select your CD-ROM drive (usually D: or E:).
Choose the picture(s) you want to include.
Click OK.

Select the category in which you wish to file your pictures. These 
will become part of your Power Album Gallery and will be accessible through
Calendar Creator.

Microsoft Scenes™-Microsoft Corporation®

Select “Scenes Wizard.” 
Select “Create a Collection Wizard.”
Type in a name and click “Next” and the “Add a Scene” dialogue box
appears.
Select your CD ROM drive (usually D: or E:).
Open the CONTENT Folder. Open Folder with subject name (e.g. ANIMLS).
Choose the desired image(s) from filename list.
Select either “ADD” or “ADD ALL.” The picture(s) will be imported in the 

same order as they were selected.
You may check the Preview to see a preview of the picture.
When finished selecting pictures, select “Done” and then select “CLOSE.”

Pictures NOW! images are now available as WALLPAPER or SCREEN SAVER
illustrations.

Print Shop Deluxe™-Brøderbund Software, Inc.®

To insert a Pictures NOW! image into an open document:
Select type of document desired.
Select “Object” from menu bar.
Select “Add”, then select “TIFF Bitmap.”
Double-click the small “TIFF” button which appears and a File Dialogue 

“Select A TIFF Bitmap” box will appear. 
Select your CD ROM drive (usually D: or E:).
Open the CONTENT Folder. Open Folder with subject name (e.g. ANIMLS).
Choose the desired image from filename list.
Click OK.

Microsoft Word™-Microsoft Corporation®

To insert a Pictures NOW! image into an open document: 
Select “Insert” from menu bar.



Select “Picture.” 
When the dialogue box opens, select the CD-ROM drive (usually D: or E:).
Open the CONTENT Folder. Open Folder with subject name (e.g. ANIMLS).
Choose the image you wish to import from filename list.
Click OK.

Microsoft Publisher™-Microsoft Corporation®

To import a Pictures NOW! image onto a page in MS Publisher:
Select “File” from menu bar.
Select “Import picture.”
Select the CD ROM drive (Usually D: or E:). 
Open the CONTENT Folder. Open Folder with subject name (e.g. ANIMLS).
Choose the image you want. You will see a preview.
Click OK.

WordPerfect™-WordPerfect Corporation®

To import a Pictures NOW! image into an open document:
Select “Insert “ from menu bar.
Select “File.”
Select the CD-ROM drive (Usually D: or E:).
Open the CONTENT Folder. Open Folder with subject name (e.g. ANIMLS).
Choose the desired image from filename list.
Click OK.

After Dark™-Berkeley Systems®

Create a customized screen saver using images from your Pictures NOW disc.
Follow the instructions outlined in your After Dark user manual under “The Logo
Module,” “The Picture Frame Module” and “The Slide Show Module.”

INSTRUCTIONS FOR MACINTOSH USERS
Start Up.

1. Insert the CD-ROM disc into your CD-ROM drive (using a disc caddy if 
appropriate.)

2. Select the icon “Install Me First.”
3. Select “Easy Install.”  
4. Restart your computer when prompted to do so.



Browsing with Kudo. 

To search Pictures NOW! and select the images you want to use, 
find the Pictures NOW! icon in the MAC_KUDO folder. double-click on the icon
to launch Pictures NOW! You will see a catalog window with thumbnail images
on your monitor. 

Use the three “View” buttons at the top left of the catalog window to select the
view you prefer. 

Small Gallery View, the left-hand view button, shows many images at once at 1/4
their normal size, but with no file details. Click the “Info” button at the top of
the screen for more information on any selected thumbnail.

The Gallery View, the center view button, uses a grid style layout showing sever-
al thumbnails and their file type. Click the “Info” button for more information.

List View, the right-hand view button, uses a vertical layout with fewer thumb-
nails in the window, but offers more information about each file.

You can scroll through the images grouped by subject on the disc, or search for
specific images. To find groups or sets of images by type or subject, use the
“Find” button, top left of the catalog window. Select “Keywords” from the first
pull-down menu in the Find dialog box. Type the subject or word you wish to
search for in the right-hand text field, then click “Find.” The thumbnail images
containing your keyword will appear in the window. If no matches are found, try
another keyword.

You may also sort images using the other search options offered in the pull-
down menus. A printed Picture Index is included in each package to make your
image search easier.

To preview any image, double-click on its thumbnail. Kudo will find the actual
image and display it in a full-sized window. Check the “Better Colors” box to
view an enhanced image on 256 color monitors. Click the “Close Window” box
in the upper left corner of the window to exit the preview utility.

Importing Pictures NOW!™ images into your favorite programs.

In some applications, simple cut and paste procedures will work. In others, a short
set of application-specific procedures must be followed. Here is a partial list of



applications which have been tested with Pictures NOW™. If the application you are
using is not listed here, check the index of your application documentation for
“importing” and/or “pictures” and follow the instructions in the manual provided with
the software.

Macintosh Applications – Specific Import Procedures
Print Shop Deluxe™-Brøderbund Software, Inc.®

To import a Pictures NOW! image into an open card, poster, etc.:
Select “File” from the menu bar.
Select “Import.”
Open Pictures NOW! CD.
Open CONTENT Folder.
Open Folder with full subject name (e.g. ANIMALS not ANIMLS).
Select “Import PICT.”
Choose desired image.
Click on “Import.”

Calendar Creator™-Softkey International, Inc.®

First, copy the desired image to the clipboard:
Open Pictures NOW!. 
Using the image browser, select the picture you want to use
Click on desired picture.
Select “Copy” from the “Edit” menu bar. (This puts a copy onto the clipboard.)
Then: Open the event list into which you wish to import.
Select “Add” or “Modify” event.
Click on the picture box.
Specify size desired.
Select “Paste.”
Click OK.

Card Shop Plus! Deluxe™-Mindscape®

To import a Pictures NOW! image into an open card, poster, etc.:
Select “File” from the menu bar.
Select “Import Picture.”
Open Pictures NOW! CD.
Open CONTENT Folder.
Open Folder with full subject name (e.g. ANIMALS not ANIMLS).
Select desired image.
Click “Import.”



Microsoft Word™-Microsoft Corporation®

To insert a Pictures NOW! image into an open document:
First, copy the desired image to the clipboard:

Open Pictures NOW! 
Using the image browser, select the picture you want to use.
Click on desired picture.
Select “Copy” from the “Edit” menu bar. (This puts a copy onto the clipboard.)
Then: Return to your MS Word document.
Put your cursor where you wish to paste your picture and Paste.

After Dark™-Berkeley Systems®

Create a customized screen saver using images from your Pictures NOW disc.
Follow the instructions outlined in your After Dark user manual under “The Logo
Module,” “The Picture Frame Module” and “The Slide Show Module.”

Technical Specifications
Dual CD-ROM for Windows and Macintosh.

Hardware & System

Requirements

Microsoft Windows
•IBM PC or 100% compatible
•386 processor or higher
•Windows 3.1 • 4Mb of RAM with
3Mb of free hard drive space 

•VGA • Hard Disk • CD-ROM
•Windows compatible mouse
•Black & white or color laser,
inkjet or 24-pin printer compati-
ble with Windows 3.1 recom-
mended

Macintosh OS
•Macintosh (all 68030 computers
and up)

•System 6.x or later (System 7
compatible)

•Hard Disk • CD-ROM

•4Mb of RAM, and 2Mb of free
hard drive space

•13” or larger size monitor (640 x
480 pixel resolution)

•Compatible with Apple’s
PowerPC™ Macintosh computers

•Black & white or color laser,
inkjet or 24-pin printer recom-
mended

File Format: TIFF and PICT

•Image File Size: 1.0Mb (approxi-
mately)

•Pixel Dimensions: 640 x 480
(approximately)

•Image Resolution: 150 pixels per
inch



WOOD RIVER GALLERY PRODUCT SUPPORT SERVICES

You can reach Wood River Gallery any of these ways:

•Telephone Product Support:  (800) 741-8570  or  (415) 388-6500
•Fax:  (415) 388-6575
•e-mail:  WoodRiver1@aol.com
In writing: Wood River Gallery

Attn:  Product Support
591 Redwood Highway, Suite 2325
Mill Valley, CA 94941

To help us serve you better, please include the following information in your 
correspondence or fax:

- Name, address, phone number and fax number
- Pictures NOW! title
- Version number and operating system
- Full text of any error messages and sample output
- Information about any applications you are using with 

Pictures NOW!

We assist you with the following:
- Placing an order for, or requesting information about

new products
- Ordering disc or manual replacements
- Checking the status of an order
- Change of address, etc.

WOOD RIVER GALLERY
Wood River Gallery is a leading publisher of digitized illustration and artwork. The col-

lection was begun in 1991 to provide the professional market with a wide variety of top-
quality illustrative imagery, and grew quickly from a few hundred original images to nearly
one million. These remarkably contemporary and beautifully colored images from popular
media and fine art were produced by more than 50,000 artists.

Known in professional design circles for producing clean, reproducible and visually
appealing illustrations, Wood River’s client/licensees include Hallmark Cards, Gibson
Greetings, Landmark Calendars and hundreds more. If you would like to use a professional,
high-resolution reproduction of any Pictures NOW!™ image in a commercial project, please
call us for pricing and a selection of additional images in your subject area.



To order additional titles, ask your retailer to stock your favorites or
complete the brochure/order form included in this package and on

this disc, or call us at 800-741-8570 (FAX 415-388-6575).
We welcome your thoughts, ideas and suggestions. 

Please drop us a line any time. Your comments are always welcome.

Sports & Recreation
Holidays & Occasions
Transportation
Valentine’s Day
Art of the World
Florals
Antique Maps of the World
Nature & Wildlife
Science Fiction
Art & Music
Cowboys and the West
Holidays & Occasions II (other
than Christmas)
Americana

Christmas Cheer
Animals
Funny Bone
People & Lifestyles
Patterns & Backgrounds
Children
Scenics & Travel
Impressionist Art
Science & Industry
The Battlefield
Christmas Cheer II
World History
Funny Bone II

Seasonals (50 images each): Mother’s Day • Father’s Day 
St. Patrick’s Day • Easter • Halloween • Graduation 

Judaica • Thanksgiving • New Year’s

Pictures NOW!

™
titles available:



Wood River Gallery • 591 Redwood Highway, Suite 2325, Mill Valley, CA 94941

© 1995 Wood River Gallery. All rights reserved. Made in USA. Pictures NOW!™
is a trademark of Wood River Gallery. Microsoft is a registered trademark and Windows is a

trademark of Microsoft Corporation. Macintosh is a registered trademark of Apple
Computer, Inc. All company and/or product names are trademark or registered trademarks

of their respective manufacturers. 

This product is provided under an enclosed licensing agreement that defines what you
may do with this product and contains limitations on warranties and available remedies.


